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Meetings of an organization at any of the facilities of the Mercer County Library System
in No Way implies endorsement of its programs
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The PPCUG Holiday Party & Elections. The food, the crowd, raffle drawings and a
winner selecting his prize at the December General Monthly Meeting.
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John Stroiney
Microsoft Marketing Representative

See a presentation on some of the exciting features of Windows ME
 and the reasons to upgrade.

Also hear about  some exciting new entertainment products.
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About PPCUG

General Meetings
Second Monday of the month at the
Lawrenceville Library.
Route 1 and Darrah Lane.
7:00-7:45 PM: Social Time / Tech Corner
7:45 PM: Meeting Comes to Order
8 PM: Featured Presentation
For information about upcoing meetings or
joining PPCUG call 908-218-0778  to leave a
message.

Board Meetings
Second Monday of the Month after the close
of the General Meeting.
Board meetings are open to All.

Board Members
President:

Paul Kurivchack ........... 908-218-0778

Vice-President:
Tom Carman ................. TBD

Secretary:
Don Arrowsmith ........... TBD

Treasurer:
Tom Canavan ............... 732-422-9055

Members-At-Large:
Jon Abolins .................. 609-883-8126
Vic Laurie ..................... 609-924-1220
Kim Goldenberg ........... 609-671-9188
Sol Libes ...................... 609-520-9024

Chairpersons
Disk Library:

Tom Canavan ............... 732-422-9055

Hospitality:
Bill Hawryluk ................ 609-655-0923

Member Records:
Paul Kurivchack ........... 908-218-0778

Newsletter Editor:
Paul Kurivchack ........... 908-218-0778

Program Coordinator:
Sol Libes ...................... 609-520-9024

Web Master:
Jon Abolins .................. 609-883-8126

Web Site
http://www.ppcug-nj.org

Annual Dues Rates
Normal dues rate is $30 per year.

New Members Only: after February, the
rate is $2.50 per month times the number of

months remaining in the year.
PublishedMonthly by:Princeton PC Users Group
PO Box 291Rocky Hill, NJ 08553©
Copyright 2000 December 2001 Vol. 17 No. 1

The reprinting of original material appearing in this
newsletter in any other publication must credit the
Princeton PC Users Group Newsletter and/or the
Princeton PC Users Group and any authors
shown. The editor and the Princeton PC Users
Group assume no responsibility or liability for
damages arising from the publication or non-
publication of any article in this newsletter.
Opinions expressed in these articles are not
necessarily those of the members of the Princeton
PC Users Group.

Coming Events

February 5, 2001 - Upgrading your PC
Tom Canavan & Paul Kurivchack will show you the inner workings of your PC

and how to do simple upgrades from memory to hard drives.

March 12, 2001 - Broadband Cable Internet Services
Learn about Cable Modems and the services provides by Comcast@Home.
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by Paul Kurivchack
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Please see Tom Canavan for the
new membership / renewal form.

It’s Y2.001K! Did you ever think we’d get through 2000 after all the
worry of last December and be thinking of starting another new year?
Well we did make it through without a scratch. Hopefully 2001, the

Space Odyssey year will bring us a continued growing economy, a slowing of the
DOT.COM deaths, new innovative personal computing products, and a wider distribu-
tion of broadband internet connections so we can all surf at light speeds or at least
something faster than 56K. Hopefully we will be covering the Broadband issue in March
with Comcast@Home and later in the year some more interesting topics. I know Sol is
already thinking about future meetings.

Y2.001K is looking brighter for the Princeton PC Users Group. After five lonely
years without a Vice President, Tom Carman graciously stepped in to take the VP post.
Tom will be a great addition to our board and I look forward to hearing his ideas in
helping the group move forward in 2001.

The hunt is still on for a new LCD projector with my continued research of the
various models available and that it will be purchased soon.

Dues are due for 2001. Please be sure to fill out a renewal form for Tom Canavan
even if you have mailed in your money. This ensures that we have a current e-mail and
postal mailing address for each of our members.

The Linux SIG is still looking for meeting space. If you have any ideas or know
someone, please take the ball and run with it, Jon will need the space soon if he wants
to continue the SIG. In addition, Caldera Systems Inc., was very generous and provid-
ed our group a good quantity of Linux OL2.3 and the Linux Technical Preview soft-
ware. Jon Abolins will be handing out the copies at his next SIG meeting.

Lastly, I hope that everyone enjoyed the food and prizes at the holiday party. Thanks
to Microsoft’s MindShare user group support organization for the software and shirts. It
is always great to go home with a present.

Have a Happy New Year and I look forward to seeing you all on the 8th.
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Windows Tips: Scrap That File
By: Vic Laurie - PPCUG

Because they pose one of the most likely, as well as potential-
ly most dangerous, problems that a typical user may encounter
when using e-mail, I am going to enlarge the discussion of virus-
es in e-mail attachments that I began in the April PPCUG news-
letter, http://www.ppcug-nj.org/newsltrs/apr2000.pdf. (For con-
venience, I am going to use the term virus to include worms and
Trojan horses although sticklers might insist on a distinction.)
In particular, I want to discuss the type of attachments that are
exemplified in two recent widespread virus outbreaks, I Love
You and Life Stages. The first makes use of a vbs file while the
latter uses an obscure type known as a scrap or shs file. Both of
these file types have perfectly legitimate applications and the
insidiousness of viruses that use them is the difficulty that both
users and anti-virus software have in distinguishing dangerous
files of these types from those that are harmless. Further, scrap
files can easily masquerade as something entirely different, mak-
ing detection even more difficult. Because many users are unfa-
miliar with these file types, let us first briefly review their nor-
mal function.

Script Files

Windows contains a very useful ability to write and use small
script files to carry out a multitude of utilitarian tasks. Web pag-
es also make use of them. The software for this is part of Win-
dows Accessories and is called Windows Scripting Host (WSH).
It provides for scripts to be written in several simple program-
ming languages including VBScript (files with extension .vbs)
and JScript (files with extension .js.) Composite programs using
several types of script can be denoted with the extension .wsh.
Scripts are easy to write and can be quite powerful. (Old-timers
will be reminded of DOS batch files; scripts are much more ver-
satile, however.) For further information go to

http://msdn.microsoft.com/scripting/
http://wsh.glazier.co.nz/default.asp
http://www.zdnet.com/pcmag/stories/solutions/
0,8224,2505166,00.html
http://www.winmag.com/fixes/2000/0901.htm

Scrap Files

A little-known type of file used in a special form of Object
Linking and Embedding (OLE) is the shell scrap object or, as it is
more usually called, scrap file. It has the (normally hidden) ex-
tension .shs. (OLE is probably unfamiliar to many readers but
basically it is the ability of certain programs to embed objects
from one program into a different program or to interchange
data between different programs. For example, part of an Excel
spreadsheet can be embedded in a Word document.) Scrap files
are an executable format and can be used to wrap or contain
executable files. See the Microsoft Knowledge Base article at
http://support.microsoft.com/support/kb/articles/Q138/2/75.asp
for further information. Also, there is a detailed article at http:/
/www.pc-help.org/security/scrap.htm, which I highly recommend.

How Virus Writers Use These Files

Unfortunately, virus writers have taken advantage of both
scripts and scraps to produce harmful files which are attached to
e-mail messages. The ease of writing scripts means that many
small variations on the same virus theme can be produced. Scrap
files can be used to package and disguise an unlimited variety of
harmful executables. Because small changes to the same basic
virus can be made continually, there is no way for the database
of virus definitions used by anti-virus software to keep up. The
anti-virus software companies do try with certain heuristic meth-
ods against these and other polymorphic viruses but there will
always be new variations. Hence, relying on anti-virus software
alone is not sufficient and additional security steps should be
taken.

Protective Measures

It is essential that users make the change in settings described
in the December PPCUG article on file extensions (shttp://
www.ppcug-nj.org/newsltrs/dec00.pdf) so that a .vbs file will be
recognized. A virus writer might name a file somefile.txt.vbs, for
example. If extensions are hidden (the Windows default set-
ting) the file will show as somefile.txt, possibly leading a user to
believe the file is a harmless text file. Even worse is the espe-
cially sneaky aspect of scrap files provided by the Windows de-
fault setting, which always hides the extension .shs even if you
do change the Show All Files sSetting. Thus a file whose real
name is somefile.txt.shs will always appear as somefile.txt, laying
a trap for the unwary. To see the .shs extension, the Registry
must be edited. After first backing up, use REGEDIT or other
Registry editor to delete the Registry entry
HKEY_CLASSES_ROOT\ShellScrap\NeverShowExt.
(Those who regard the Registry as a Twilight Zone never to be
entered may wish to disable Scrap files. See below)

Having made sure that extensions are shown, an e-mail recip-
ient should next follow these three rules:

1. Never open or double-click an attachment unless abso-
lutely sure what it is.
2. Never open or double-click an attachment unless abso-
lutely sure what it is.
3. Never open or double-click an attachment unless abso-
lutely sure what it is.

Yes, I know, that sort of repetition is corny, but being careless
about opening attachments is the major cause of trouble with e-
mail viruses. Countless numbers of people clicked on files from
complete strangers saying, “I love you.” It may be tedious to
check out each and every attachment but doing so will obviate
a lot of possible problems.

Also, the security measures for configuring Internet Explorer
and Outlook Express discussed in http://www.ppcug-nj.org/news-
ltrs/apr2000.pdf should be put in place by those who use this
software. This will place e-mail scripts into a restricted security
zone.

 If you never use .vbs or other script files (I find them very
useful but they are not for everybody) and are prepared for error

Windows Tips continued on Page 4
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Windows Tips continued on page  5

messages from some Web pages, remove the Windows Scripting
Host. A discussion of the pros and cons of doing this is at http:/
/www.zdnet.com/zdhelp/stories/main/0,5594,2573079,00.html.
Then the system will not be able to run  .vbs files (or .js or .whs
or some others). Windows 9X users (but apparently not Win-
dows Me users who can use the alternate procedure given be-
low) can go to Control Panel|Add/Remove
Programs|Windows Setup. Select Accessories (Fig. 1). Click
Details and scroll to Windows Scripting Host and remove the check-
mark. (Fig. 2) Click OK.

Figure 1

Figure 2

Windows Tips continued from Page 3 A cruder but faster way to disable scripting is to go to the
Windows folder and simply rename or delete the file wscript.exe
and in \Windows\Command\ rename or delete the file
cscript.exe. This still leaves references to scripting in the Regis-
try; they do no harm but tidy people may want to use the unin-
stallation procedure.

If you wish to retain Windows Scripting Host and the capac-
ity to use scripts, one safety measure is to change the default
action from Open to Edit. An inadvertent double-click will then
merely open the file in Notepad rather than running it. Win-
dows 9X users can go to Control Panel, open the View menu,
Folder Options|File Types, scroll to VBScript Script File (there
will be two entries, one for vbs and one for vbe), (Figure 3) (Win-
dows Me users will find an icon for Folder Options in Control
Panel.) Click the Edit button and change the default action
from Open to Edit, (Figure 4). Do the same for other script types
(js, jse, wsf, wsh). Incidentally, since script files are in text, those
with even a small amount of familiarity with script language
can tell what kinds of things the script might be doing.

Figure 3
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Figure 4

Yet, another measure is to install the free utility “Watchdog”
from Winmag that is available at http://www.winmag.com/fix-
es/watchdog/default.htm. Trying to open a script file will then
bring up a window warning you of possible dangerous actions.
This can get tiresome if you use many legitimate scripts but for
those who only occasionally use scripts it provides a useful layer
of safety. Another useful freeware program aimed specifically at
Outlook users can be found at http://www.zdnet.com/zdhelp/sto-
ries/main/0,5594,2595248,00.html.

Those who do not mind the possibility of losing certain types
of functionality in Microsoft Office or other applications may
wish to disable Scrap files altogether. Go to Control Panel, open
the View menu, Folder Options|File Types, scroll to Scrap
Object, highlight it and click “Remove.” (Windows Me users
will find an icon for Folder Options in Control Panel.) Or go to
the folder \Windows\System\ and delete or rename the file
shscrap.dll. Keep in mind that the potential danger from Scrap
files is from the executables that can be wrapped in them, not
from the Scrap file per se. For example, The Life Stages worm
uses a scrap file to wrap a vbs program. The article mentioned
above at http://www.pc-help.org/security/scrap.htm has many
details.

Netscape 4.7 users can go to the Edit menu and open
Preferences|Navigator|Applications. Scroll down the list
“Description” to Scrap Object. Click “Remove”. This removes
Scrap file support from the Internet functions. Also you can go
to Preferences|Advanced and remove the check by “Enable
JavaScript for Mail and News”. Note that JavaScript and Jscript
are similar but not identical, being part of the Netscape-Mi-
crosoft dichotomy. Also, as far as I know, Netscape 4.7 does not

Windows Tips continued from Page 4 support vbs files although it does support vbe. The list of sup-
ported applications given in
Preferences|Navigator|Applications can be edited to remove
any of the Netscape supported scripting functions that the user
may choose. Note that lack of Netscape support does not pre-
clude dangers from opening downloaded files whose file type is
supported by Windows. It only means that Netscape cannot au-
tomatically open such files.

Other Potentially Dangerous Files

There are, of course, many other file types that virus writers
can use for malicious purposes as e-mail attachments. It is im-
possible to mention them all in our limited space but a list of
potentially unsafe file types can be found at

http://www.winmag.com/columns/powertools/filetypes.htm.
Common sense is the best general defense; making sure you can
read extensions and following rules 1-3 mentioned above will
keep you out of a lot of potential trouble.

Keep Updated

Be sure to do frequent updates of your anti-virus definitions.
Also, there has been a steady (some would say never-ending)
stream of security patches. Be sure to apply any that seem rele-
vant to your system. See http://www.ppcug-nj.org/articles/
vic_laurie/lookback.html for how to keep up. Microsoft has been
trying to patch up Outlook, for example, to deal with some of
these e-mail problems. See http://www.microsoft.com/technet/
security/virus.asp for the latest security bulletins. Netscape us-
ers can go to http://home.netscape.com/security/notes/
index.html.

Acknowledgement

My thanks go to Joel May for comments on the use of scripts
in Web pages and to Sol Libes for filling me in on aspects of
Windows Me.
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Minutes for the General Meeting
December 11, 2000
By: Ed Weiss

General Monthly Meeting
Schedule for 2001

January 8, 2001 – Monday

February 5, 2001 – Monday* - First Monday

March 12, 2001 – Monday

April 9, 2001 – Monday

May 14, 2001 – Monday

June 11, 2001 – Monday

July 9, 2001 – Monday

August 13, 2001 – Monday

September 10, 2001 – Monday

October 15, 2001 – Monday* - Third Monday

November 12, 2001 – Monday

December 10, 2001 – Monday

Note: All dates are for the second Monday of the Month
except for February (Library Closed) and October (Colum-
bus Day) falling on the second Mondays.

At 08:07 PM, Paul opened the meeting, the first item on the
agenda was the election of the new officers.  Unlike the situa-
tion in Florida, we did NOT have any recounts, nor any law
suits over the final numbers.  And the winners are:

Paul Kurivchack - President,
Tom Carman - Vice President,
Don Arrowsmith - Secretary,
Tom Canavan - Treasurer,
John Abolins, Kim Goldenberg and Sol Libes - Members At

Large
 
Congratulations to the new members, and those continuing

to serve.  Thanks to those leaving their board positions.
The next item was a listing of the schedule of programs.  In

January, Microsoft will be giving a presentation.  In February,
our own Paul and Tom will due a presentation on building your
PC.  (NOTE: the February meeting will be on the first Monday
of the month.)  And in March, we have Comcast lined up to
present to the group.

Also of note, is that there will be NO board meeting this
month.

The Linux SIG is still looking for a meeting place, and any-
one with any ideas on places where the SIG could meet should
contact John Abolins or Paul Kurivchack.

With all the business activities out of the way, the Christmas
party began, and as the members sampled all the food and drink,
there were many topics being discussed in different areas of the
room.  About 9:15 PM, Paul gathered in the badges from the
remaining attendees, and the drawings for the door prizes be-
gan.  Congratulations to all the winners of the door prizes.  At
9:25 PM the meeting and party were closed.  Thanks to all the
members who stayed to help clean up the room, and put away
the chairs.  Happy Holidays to all..

Final minutes by Ed Weiss

Con jobs have be with us from time immemorial. Con artist
move to whever opportunities present themselves. They are fast
to explore ways to scam people using new technologies, such as
the telephone or the Internet. Here are some helps to prevent
being defrauded.

U.S. Federal Trade Commission

- “Dot Con” - Top 10 Online Scams:
http://www.ftc.gov/bcp/conline/edcams/dotcon/index.html

- International Telephone Number Scams:
http://www.ftc.gov/bcp/conline/pubs/tmarkg/intlphon.htm

National Fraud Information Center

-   http://www.fraud.com/

New Jersey Division of Consumer Affairs

- http://www.state.nj.us/lps/ca/home.htm

ScamBusters.org

- http://www.scambusters.com/

Sites to Fight Scams
By: J.D. Abolins - PPCUG
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PPCUG Member E-mail Directory
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(Last Update: December 4,  2000)
Send Updates to kurivchack_p@compuserve.com for inclusion in this listing.

Name E-Mail
Last First Address

Name E-Mail
Last First Address
Abolins John D. jda-ir@njcc.com
Adler Seymour syadler@aol.com
Arrowsmith Donald L. donald.arrowsmith@bigfoot.com
Axelrod Albert aaxelrod@erols.com
Best John J. jjbest57@alum.mit.edu
Bolge Eleanor embolge@jersey.net
Canavan Thomas tcanavan1@aol.com
Caris Paul D. pdcaris@yahoo.com
Carman Thomas tom_carman@compuserve.com
Chilton Neal W. chilforce@aol.com
Cohen Jon jon@pluto.njcc.com
Colucci Frank E. DasWeb1@aol.com
Crossley Helen M. CrossleyHM@aol.com
Davis Perry J. perrydavis@compuserve.com
Dinkins-Belton Joyce Joyce8NJ@aol.com
Dodge William B. b-mdodge@juno.com
Donovan Kyle R. stoneflykd@aol.com
Duggins Marsha msd@gfdl.gov
Edge, Jr. Lewis A. lewis@edgeassoc.com
Einthoven Bella einthoven@mail.eclipse.net
Ewer Tim tjewer@worldnet.att.net
Farah Avi avifarah@netzero.net
Foulkes Frank ffoulkes1@aol.com
Gibson Dawson H. wkgbill@earthlink.net
Goldberg Edwin M. EdGoldberg@home.com
Goldenberg Kim kim_goldenberg@bigfoot.com
Goodkin Jerry goddkin@erols.com
Griegel Wayne B. wgriegel@ix.netcom.com
Gunther Bruce W. bg1509@hotmail.com
Hardy Wayne wayne97wh@aol.com
Hawryluk Bill hawr@compuserve.com
Henry Chuck chenry@eclipse.net
Hirsh Donald J. djhirsh@earthlink.net
Holly Lois lois@audet.com
Johnson Florence kredit@erols.com
Juelch H. Karl karljnj@nerc.com
Kahan Maurice mkahan@juno.com
Kamat Prakash mandpt92@hotmail.com
Kerslake David dongsung@juno.com
Kleinerman Irma rafiki@iopener.net
Kleinerman Milton kukumafi@Juno.com
Konvalinka John W. jkonvalinka@msn.com
Koosman Milton miltonk2@aol.com
Krisak Bill BobKrisak@worldnet.att.net
Kurivchack Paul kurivchack_p@compuserve.com

Landis Houston E. judge@alumni.princeton.edu
Laurie Vic hampsi@bigfoot.com
Lazar Joseph joelazar@nerc.com
Lewis Lloyd N. Budnorth@juno.com
Libes Sol sol@libes.com
Markward Margaret mteragram@aol.com
Maruska John maruska1@juno.com
Metzler Joseph 76116.3117@compuserve.com
Middleton Frank ftmprob@nerc.com
Miller Douglas E. D.N.Miller@worldnet.att.net
Mintz Herman hmintz4@aol.com
Montani Linda l.montani@worldnet.att.net
Mooney William P. wmo8350722@aol.com
Oldenburg Thomas A. oldenburg-ta@worldnet.att.net
Olson Gaylord go@electrim.com
Papier, Jr. Philip B. papierp@superlink.net
Phadke Laxman G. layogph@aol.com
Pitcher Barbara bpitcher@ets.org
Polignano Vince vincepo@worldnet.att.net
Pratt Zeblon H. zpratt@aol.com
Reichart Richard reichart@pluto.njcc.com
Rothstein Rick fnroth@aosi.com
Rouse H. Ronald DrRonRouse@aol.com
Rutzky Mark M. marky@infi.net
Sked Bill billsked@aol.com
Steinman Arthur M. amsteinman@aol.com
Stockwell Hunt huntstock@aol.com
Suber Michael J. mpsuber@juno.com
Sweeton Andrew asweeton@roper.com
Tayyabkhan Mike tayyabkhan@aol.com
Tenner Edward tenner@clarity.princeton.edu
Treadwell Isaac itreadwell@msn.com
Walthall Ronald K. DKDM83A@prodigy.com
Weinberg Robert bweinb@worldnet.att.net
Weiss III Edward A. eweiss@nerc.com
Williams Ken krw1948@worldnet.att.net
Willis Lloyd lwillis1@prodigy.net
Willis Robert S. Robert4269@aol.com
Wolff William V. wvwa@bellatlantic.net
Shah Sonal sonals@microsoft.com

About Weird Bytes -- Usage Conditions

Weird Bytes comic strips may be used for free by computer
users groups and other not-for-profit groups. The comic strips
should include the copyright notice and the Weird Bytes Web
address. As a favor, please send an email indicating the users
group or publication.
Personal use as desktop wallpaper images and such are also
free of charges.
Should you want to change the text or pictures in the comic
strips, please indicate that you’ve modified the original comic
strip. If you find a typos that needs to be corrected, go ahead,
correct it. Please let me know of the typo. I’ll go to a mirror
and reprimand the quality control person I see in the mirror.
You may translate the text in the comic strips into other
languages so your readers can understand the comic strips.  If
you do this, please send me a copy of the translation for my
archives.
For commercial use of the images, please contact Weird Bytes.
Thank you.
J.D. Aboilins ---- weirdbytes@meydabbs.com



Princeton PC Users Group
P.O Box 291
Rocky Hill, NJ  08553

Directions To Our Meeting:

The Lawrence Library is at the corner of Business Route 1 South and Darrah Lane.
From Princeton and North: Take US Route 1 South, past the Quaker Bridge / Mercer Shopping Centers. Continue on approxi-

mately 1 3/4 mile past I295 to the  Route 1 split, stay to the right to Business Route 1(Brunswick Pike). First traffic light is Darrah
Lane. Library is on right side. Park in lot towards Route 1 and to the rear. Enter Library at main enterance in front. Meeting rooms
A & B are located through glass door on Route 1 side of building.

From Trenton and South: Take I295 North to US Route 1 South. Library is approximately 1 3/4 miles south of I295. Continue
south to Business Route 1(Brunswick Pike). First traffic light is Darrah Lane. Library is on right side. Park in lot towards Route 1 and
to the rear. Enter Library at main enterance in front. Meeting rooms A & B are located through glass door on Route 1 side of
building.

For additional information visit http://www.ppcug-nj.org

���������	
����
�	��

�������	��	����

��
�����	�������


